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Introduction of R

2020.2.6

東京大学こころの多様性と適応の統合的研究機構（UTIDAHM）

小池進介

Statistical softwares
SPSS R Excel

配布元 IBM The R project Microsoft

価格 Base ¥115,560
Options ¥63,936 / per 1 opt
(学生パック ¥10,000-
20,000)

Free! ¥15,000-30,000

OS Win, Mac, Linux Win, Mac, Linux Win, Mac

何ができる
か？

基本から応用まで
(Optionsによる！)

基本から応用まで
(Install packages)

基本

利点 • GUI base
• 心理学データにマッチ
• スクリプトが簡単

（GUIから吐き出せ
る）
• 疑問はGoogleで解決

• All free
• カスタマイズが用意
• 非常に多くのパッケージ
• 応用編の解析も比較的簡単
• 疑問はGoogleで解決

(ただし、難易度が高く、
英語の

場合もしばしば）

• Datasheet base
• 全員使える
• 心理学データにマッ

チ
• 疑問はGoogleで解決

欠点 • 非常に高価
• 応用編の解析は視覚的に

できるとはとても思えな
い

• CUI base • 信用されない
• 応用解析はない
• 大規模データに向か

ない
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Example of SPSS

Example of R (Rstudio)
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FIRST TRY RSTUDIO!

RStudioの起動

• ./Rintro/seminar script.R をクリック

• RStudioを起動後、ファイルを選択
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RStudioの起動

RStudioの起動

色やフォントが違います
Tools→Global Options→Appearance

まだインストールされていないlibraryが表示されます
ここでクリックしたらインストールされます
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Working directoryの変更

• setwd(“directory path”)

• 右下の枠内にある設定で

– More→Set As Working Directory
どこを表示しているか
見当がつかない方は
ここをクリック

R (RStudio)の基本ルール１
• 大文字と小文字は異なります

– view(x) or View(x)

• 代入は <- or =

• 改行で実行

• （）は閉じない限り実行されない
– 視覚的には横に長くなりすぎるなら改行

• スペースは空けても空けなくても良い
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R (RStudio)の基本ルール２

• #以降はコメントです（実行されません）

– プログラムの右側にコメントを書くことも可能

• 該当部分をコメントにしたい場合

• 該当箇所を実行したい場合（2種類）

Macは Option + Return, Command + Return です

Macは Command + Shift + c です

データファイルの読み込み

• File -> Import Dataset -> From text (base)
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Cheat Sheet!
誰か日本語訳してください
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data1.csv

• id

– 50 participants

• sex

– 25:25

• var1~var30

– Randomly input 1~100

簡便なデータチェックの方法

• summary(x)

• head(x)

– head(x, n=10)
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変数タイプ（後述）

View(x)
（最初は大文字）

Q1

• 男女差があるか検討してみましょう

t.test(var1 ~ sex, var.equal = T)

• var1~var30 のどの変数が男女差があるか検討
してみましょう
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R (RStudio)の基本ルール３

• 定義されたオブジェクトは”x”であって、”sex”等ではない

• 選択するためには、
– x$sex 等と＄でつなぐ

t.test(x$var1~x$sex)

– 行列番号を指定する
t.test(x[,3]~x[,2])

– attach(x) を実行する
attach(x)
t.test(var1~sex)

行列の指定方法
x[1,] : 1行目のベクトル
x[,2] : 2列目のベクトル
x[1,2] : 1行目2列目のスカラー

sexを独立変数、var1を従属変数としたｔ検定（等分散仮定せず）

attachしたオブジェクトは、detach()で解除されます
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for 構文
• 先に”t.test.sex()”関数を定義して繰り返す

• 文字列の結合（paste関数）と文字列の実行（eval(parse)関数）を組み合わせる

なお、Rの for 構文は癖があるようで、ほかのプログラミング言語とは少し違うようです

t.test.sex(3) を実行すれば
print(t.test(x[,3] ~ …
が実行される関数を作成

t.test.sex(i) を i = 3~32 で実行

paste関数:文字列の結合、例えば i = 1 なら、
print(t.test(x$var と 1 と ~x$sex, var.equal = T)) という３つの文字列を、
間に何も挟まず（sep = “”）結合する

eval(parse(text=))関数セット
文字列を実行関数とすることができる

見づらい、記録に残せない
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R (RStudio)の基本ルール４

• sink関数： 出力結果の保存先を指定

• 49行目を実行後、再びfor構文を走らせる

• 解除は sink()

• 出力されたファイルを見て、var1~var30 のどの
変数が男女差があるか検討してみましょう

Multiple testing
• もし、独立した変数を用いて繰り返し検定したと

き、５％有意水準を満たす変数が発生する確率
は以下の通りになります
– 2変数: 1-(1-0.05)2 = 0.0975

– 3変数: 1-(1-0.05)3 = 0.143

…

– 20変数: 1-(1-0.05)20 = 0.642

• そのため、Bonferroni, FWER, FDR等の方法で有
意水準を補正したほうが良いでしょう
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SPSSと対応させたRによるデータ解析チュートリアル

2020.2.6

東京大学こころの多様性と適応の統合的研究機構（UTIDAHM）

小池進介

data2.csv

• どのような質問紙かは、data2questionnaire.docx を参照してください

• 230 participants

• Demographics
– age
– sex
– iq

• Longitudinal data (0, 1, and 2 years later)
– WHO5: wellbeing
– GHQ12: depressive symptoms
– SSQ(A, B): social support (number, satisfaction)

• Some missing values
– blank： No response
– -1： Missing values
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欠損値が２種類ある

blank： No response

-1： Missing values

R (RStudio)の基本ルール５
• データ抽出には比較演算子を用いる

== ＝
!= ≠
ほか <=, >=, <, >
また、is.null(), is.na() 等

• 例
– sex が 2 の行を抜き出す

y[y$sex == 2,]
– sex が 2 かつ iq が 100 以上の行を抜き出す

y[y$sex == 2 & y$iq >= 100,]

• 今回は -1 のものをすべてNAと置き換えたいので、次のように実行します
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R (RStudio)の基本ルール６

データ型 例 適用可能データ 構造検査 構造変換
論理値 TRUE, FALSE スカラー～行列 is.logical() as.logical()

文字列 “a”, ”b”, ”c” スカラー以上 is.character() as.character()

整数 -1, 0, 1 スカラー～行列 is.integer() as.integer()

実数 -1, 0.5, 1.23 スカラー～行列 is.numeric() as.numeric()

複素数 1 + 2i スカラー～行列 is.complex() as.complex()

順序なし因子 “Boy”, “Girl” スカラー～行列 is.factor() as.factor()

ベクトル c(1, 2, 3) ベクトル以上 is.vector() as.vector()

行列 matrix(1:6, 
nrow = 2,
ncol = 3)

ベクトル以上 is.matrix() as.matrix()

データフレーム １つ以上のベクトル ベクトル以上 is.data.frame() as.data.frame()

リスト １つ以上のデータ
セット

ベクトル以上 is.list() as.list()

• 変数の定義が重要です

R (RStudio)の基本ルール６

データ型 例 適用可能データ 構造検査 構造変換
論理値 TRUE, FALSE スカラー～行列 is.logical() as.logical()

文字列 “a”, ”b”, ”c” スカラー以上 is.character() as.character()

整数 -1, 0, 1 スカラー～行列 is.integer() as.integer()

実数 -1, 0.5, 1.23 スカラー～行列 is.numeric() as.numeric()

複素数 1 + 2i スカラー～行列 is.complex() as.complex()

順序なし因子 “Boy”, “Girl” スカラー～行列 is.factor() as.factor()

ベクトル c(1, 2, 3) ベクトル以上 is.vector() as.vector()

行列 matrix(1:6, 
nrow = 2,
ncol = 3)

ベクトル以上 is.matrix() as.matrix()

データフレーム １つ以上のベクトル ベクトル以上 is.data.frame() as.data.frame()

リスト １つ以上のデータ
セット

ベクトル以上 is.list() as.list()

• 変数の定義が重要です

Attention!
Rではfactor変数が⿁門です
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Stack point

すいません、2月5日（水）に変更したので、それ以前にダウンロードした方は
上の方にあるこちらを実行してから75行目以降を試してみてください

factorは自動判別されて読み込まれることが多々あります

回避策

• stringsAsFactors = F とする

read.csv(“aaa.csv", header = T,

stringsAsFactors = F)

• 最初からデータ型をすべて指定する

read.csv(“aaa.csv", header = T,

colClasses = c("character", “numeric", 

“factor”, rep("numeric", 15)))
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Q2

• 2年後のうつ症状(GHQ12)は、ベースラインと1
年後のうつ症状どちらから影響を受けているで
しょう

lm(ghq12_2 ~ ghq12_0 + ghq12_1, data = y)

• 2年後のうつ症状は、ベースラインのうつ症状と
Wellbeingどちらから影響を受けているでしょう

主な統計解析手法
• t test, U test
• Paired t test
• Pearson’s r, Spearman’s rho
• ANOVA, ANCOVA
• Repeated measures ANOVA
• General linear model （GLM）
• Chi square test
• Multiple regression
• Logistic regression model
• Generalized linear model
• Generalized linear mixed model
• Structure equation model
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主な統計手法の分類
検討したい従属変数、独立変数（交絡変数）の種類がわかれば、検定方法は自ずと決まります

従属変数（目的変数）
名義変数 順序変数もしくは量的変数
non-parametric parametric

独立変数
（説明変数）

名義変数

２つ
反復測定なし カイ二乗検定 Mann-Whitney 

U検定 ｔ検定

反復測定あり McNemar検定 Wilcoxon順位和
検定 paired-t検定

３つ以上
反復測定なし カイ二乗検定 Kruskai-Walis検

定 ANOVA

反復測定あり CochranのQ検定 Friedman検定 repeated-
measures ANOVA

順序変数
もしくは
量的変数

方向性なし（相関） NA Spearman's 
rho

Pearson's ｒ, 偏相
関

方向性あり ロジスティック回
帰分析

多項ロジス
ティック分析 重回帰分析

拡張
モデル

一般化線系モデル（Generalized linear model）
一般化線型混合モデル
共分散構造分析
ベイズ統計学
・・・

例題
1. 男女（Binary）間で抑うつ症状得点（continuous）

の差を知りたいとき

2. 男女（Binary）間で抑うつの有無（Binary）の差を

知りたいとき

3. 年齢層（若中老の3 category）間で抑うつ症状

得点（continuous）の差を知りたいとき

4. 年齢（continuous）と抑うつ症状得点

（continuous）の相関関係を知りたいとき

5. 年齢（continuous）が抑うつ症状得点

（continuous）に影響を与えるという因果関係を

知りたいとき

6. 年齢（continuous）が抑うつの有無（binary）に影

響を与えるという因果関係を知りたいとき

従属変数（目的変数）

名義変数 順序変数もしくは量的変数

non-parametric parametric

独立変数
（説明変
数）

名義変数

２つ
反復測定なし カイ二乗検

定
Mann-
Whitney U検
定

ｔ検定

反復測定あり McNemar
検定

Wilcoxon順
位和検定 paired-t検定

３つ
以上

反復測定なし カイ二乗検
定

Kruskai-
Walis検定 ANOVA

反復測定あり Cochranの
Q検定

Friedman検
定

repeated-
measures 
ANOVA

順序変数
もしくは
量的変数

方向性なし（相関） NA Spearman's 
rho

Pearson's ｒ
, 偏相関

方向性あり

ロジス
ティック回
帰分析

多項ロジス
ティック分析重回帰分析

拡張
モデル

一般化線系モデル（Generalized linear 
model）
一般化線型混合モデル
共分散構造分析
ベイズ統計学
・・・
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回答１
1. 男女（Binary）間で抑うつ症状得点（continuous）

の差を知りたいとき

2. 男女（Binary）間で抑うつの有無（Binary）の差を

知りたいとき

3. 年齢層（若中老の3 category）間で抑うつ症状

得点（continuous）の差を知りたいとき

4. 年齢（continuous）と抑うつ症状得点

（continuous）の相関関係を知りたいとき

5. 年齢（continuous）が抑うつ症状得点

（continuous）に影響を与えるという因果関係を

知りたいとき

6. 年齢（continuous）が抑うつの有無（binary）に影

響を与えるという因果関係を知りたいとき

従属変数（目的変数）

名義変数 順序変数もしくは量的変数

non-parametric parametric

独立変数
（説明変
数）

名義変数

２つ
反復測定なし カイ二乗検

定
Mann-
Whitney U検
定

ｔ検定

反復測定あり McNemar
検定

Wilcoxon順
位和検定 paired-t検定

３つ
以上

反復測定なし カイ二乗検
定

Kruskai-
Walis検定 ANOVA

反復測定あり Cochranの
Q検定

Friedman検
定

repeated-
measures 
ANOVA

順序変数
もしくは
量的変数

方向性なし（相関） NA Spearman's 
rho

Pearson's ｒ
, 偏相関

方向性あり

ロジス
ティック回
帰分析

多項ロジス
ティック分析重回帰分析

拡張
モデル

一般化線系モデル（Generalized linear 
model）
一般化線型混合モデル
共分散構造分析
ベイズ統計学
・・・

回答２
1. 男女（Binary）間で抑うつ症状得点（continuous）

の差を知りたいとき

2. 男女（Binary）間で抑うつの有無（Binary）の差を

知りたいとき

3. 年齢層（若中老の3 category）間で抑うつ症状

得点（continuous）の差を知りたいとき

4. 年齢（continuous）と抑うつ症状得点

（continuous）の相関関係を知りたいとき

5. 年齢（continuous）が抑うつ症状得点

（continuous）に影響を与えるという因果関係を

知りたいとき

6. 年齢（continuous）が抑うつの有無（binary）に影

響を与えるという因果関係を知りたいとき

従属変数（目的変数）

名義変数 順序変数もしくは量的変数

non-parametric parametric

独立変数
（説明変
数）

名義変数

２つ
反復測定なし カイ二乗検

定
Mann-
Whitney U検
定

ｔ検定

反復測定あり McNemar
検定

Wilcoxon順
位和検定 paired-t検定

３つ
以上

反復測定なし カイ二乗検
定

Kruskai-
Walis検定 ANOVA

反復測定あり Cochranの
Q検定

Friedman検
定

repeated-
measures 
ANOVA

順序変数
もしくは
量的変数

方向性なし（相関） NA Spearman's 
rho

Pearson's ｒ
, 偏相関

方向性あり

ロジス
ティック回
帰分析

多項ロジス
ティック分析重回帰分析

拡張
モデル

一般化線系モデル（Generalized linear 
model）
一般化線型混合モデル
共分散構造分析
ベイズ統計学
・・・
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回答３
1. 男女（Binary）間で抑うつ症状得点（continuous）

の差を知りたいとき

2. 男女（Binary）間で抑うつの有無（Binary）の差を

知りたいとき

3. 年齢層（若中老の3 category）間で抑うつ症状

得点（continuous）の差を知りたいとき

4. 年齢（continuous）と抑うつ症状得点

（continuous）の相関関係を知りたいとき

5. 年齢（continuous）が抑うつ症状得点

（continuous）に影響を与えるという因果関係を

知りたいとき

6. 年齢（continuous）が抑うつの有無（binary）に影

響を与えるという因果関係を知りたいとき

従属変数（目的変数）

名義変数 順序変数もしくは量的変数

non-parametric parametric

独立変数
（説明変
数）

名義変数

２つ
反復測定なし カイ二乗検

定
Mann-
Whitney U検
定

ｔ検定

反復測定あり McNemar
検定

Wilcoxon順
位和検定 paired-t検定

３つ
以上

反復測定なし カイ二乗検
定

Kruskai-
Walis検定 ANOVA

反復測定あり Cochranの
Q検定

Friedman検
定

repeated-
measures 
ANOVA

順序変数
もしくは
量的変数

方向性なし（相関） NA Spearman's 
rho

Pearson's ｒ
, 偏相関

方向性あり

ロジス
ティック回
帰分析

多項ロジス
ティック分析重回帰分析

拡張
モデル

一般化線系モデル（Generalized linear 
model）
一般化線型混合モデル
共分散構造分析
ベイズ統計学
・・・

R, SPSS対応表

SPSS R

重複ケースの特定
ケースの並び替え
Sort cases by id.

X[order(x$id,decreasing=F),]

変数の並び替え
行と列の入れ替え t(x)

ファイルの結合（変数の追加） x <- cbind(x, new.var)

ファイルの結合（ケースの追加） x <- rbind(x, new.case)

再構成
ファイルの分割 x.male <- x[x$sex==1,]

x.female <- x[x$sex==2,]ケースの選択
ケースの重み付け table()

他の変数への値の再割り当て
recode age (0 thru 19=1)(20 
thru 49=2)(50 thru 
99=3)(else=sysmis).
recode age (-1=sysmis)(0 thru 
19=1)(20 thru 49=2)(50 thru 
hi=3) into agecategory.

expss::recode(x$age) = c(0:19 ~ 1, 20:49 ~ 2, 50:99 ~ 3, 
other ~ NA)

x$agecategory = recode(x$age, -1 ~ NA, 0 %thru% 19 ~ 1, 
20 %thru% 49 ~2, 50 %thru% 99 ~ 3, other ~ copy)
recode(x$age, -1 ~ NA, 0 %thru% 19 ~ 1, 20 %thru% 49 
~2, 50 %thru% hi ~ 3) %into% x%agecategory

連続変数のカテゴリ化 x$agecategory <- ifelse(x$age>20,1,0)

* SPSSの場合、大文字小文字の区別はない。最後にピリオド(.)で締める必要がある。
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R, SPSS対応表

SPSS R

記述統計:度数分布表
記述統計:クロス集計表 chisq.test(x$sex,x$category)

chisq.test(x$sex,x$category)$residuals #post-
hoc residual analysis

平均の比較:グループの平均 mean(x$age, na.rm = T)

平均の比較:１サンプルのｔ検定
平均の比較:独立したサンプルのｔ検定 t.test(x$age ~ x$sex, var.equal = T)

平均の比較:対応のあるサンプルのｔ検定 t.test(age1, age2, paired=T)

平均の比較:一元配置分散分析 summary(aov(x$age ~ x$3categories))
summary(aov(age ~ 3categories, data = x)) 
anova.result <- aov(age ~ 3categories, data = 
x)
summary(anova.result)
TukeyHSD(anova.result)

一般線形モデル:１変量 lm()

一般線形モデル:多変量
一般線形モデル:反復測定 aov(var1 ~ age * sex +

Error(ID), data = x)
OR

https://www.wantedly.com/companies/diligenc
e/post_articles/74556

R, SPSS対応表

SPSS R
一般化線形モデル glm
混合モデル:線形 lmer
混合モデル:一般化線形 glmer or nlme packages
相関:２変量 cor.test(x$age,x$iq)

psych::corr.test(x)  # correlation 
matrix

相関:偏相関
回帰:線形 lm(sex ~ age + iq, data=x)
回帰:二項ロジスティック glm(sex ~ age + iq, data=x, 

family=”binomial”)
回帰:多項ロジスティック
次元分解:因子分析 See page below
ROC曲線

41

42



2020/2/5

22

R, SPSS対応表

SPSS R
グラフ:棒 plot(x$sex)
グラフ:折れ線
グラフ:円
グラフ:箱ひげ図 boxplot(x$age)

boxplot(x$age ~ x$sex)
boxplot(age ~ sex, data = x)
plot(age ~ sex, data = x)
plot(age ~ sex + categories, data = 
x)

グラフ:エラーバー
グラフ:散布図 plot(x$ghq12 ~ x$age)
グラフ:ヒストグラム hist(x$age)

Excel, SPSS対応表

Excel R

countif expss::count_if(1,x$sex)
expss::count_col_if(gt(20),x$age)
expss::count_row_if(le(0),x)

sumif expss::sum_if(gt(20),x$age)

vlookup expss::vlookup(x$id,newlist,2)
expss::vlookup(x$id,newlist,”new.va
r”)

<1 lt(1)
<=1 le(1)
<>1 ne(1)
=1 eq(1)
>=1 ge(1)
>1 gt(1)

First column of the ‘newlist’ should be the lookup variable (i.e. id). 
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EZRの紹介
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